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Welcome to RBInstaller!

The RBInstaller is a Windows Installer authoring tool. It offers a
friendly and easy to use graphical user interface for creating and
maintaining reliable installation packages for Microsoft Windows
desktop and server platforms.
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1 Introduction

1.1 Introducing RBInstaller 2.0

The RBInstaller is a Windows installer authoring tool. It offers a friendly and easy to use graphical user
interface for creating and maintaining reliable installation packages for Microsoft Windows desktop and
server platforms.

The complexities of RBInstaller are simplified and incorporated into the intuitive interface, so users may
easily build an install package without understanding the complicated inner workings of RBInstaller. With
a few mouse clicks, the flexible interface will result in a fully-functional installation executable. 

Installer projects can be saved and loaded into RBInstaller allowing you to manage multiple product
installation packages. 

RBInstaller has been used in thousands of setup.exe installations with reliable results. 

1.2 Copyrights

Information in this document, including URL and other Internet web site references, is subject to change
without notice. The example companies, individuals, products, organizations and events depicted herein
are completely fictitious. Any similarity to a company, individual, product, organization or event is
completely unintentional. R:BASE Technologies, Inc. shall not be liable for errors contained herein or for
incidental consequential damages in connection with the furnishing, performance, or use of this material.
This document contains proprietary information, which is protected by copyright. Complying with all
applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any
purpose, without the express written consent of R:BASE Technologies, Inc. We reserve the right to make
changes from time to time in the contents hereof without obligation to notify any person of such revision
or changes. We also reserve the right to change the specification without notice and may therefore not
coincide with the contents of this document. The manufacturer assumes no responsibilities with regard to
the performance or use of third party products.

Products that are referred to in this document may be either trademarks and/or registered trademarks of
the respective owners. The publisher and the author make no claim to these trademarks.

The software described in this document is furnished under a license agreement. The software may be
used or copied only in accordance with the terms of that agreement. Any unauthorized use or duplication
of the software is forbidden.

R:BASE Technologies, Inc. may have patents, patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in any
written license agreement from R:BASE Technologies, Inc., the furnishing of this document does not give
you any license to these patents, trademarks, copyrights, or other intellectual property.

Trademarks

R:BASE®, Oterro®, RBAdmin®, R:Scope®, R:Mail®, R:Charts®, R:Spell Checker®, R:Docs®, R:BASE
Editor®, R:BASE Plugin Power Pack®, R:Style®, RBZip®, R:Mail Editor®, R:BASE Dependency Viewer®,
R:Archive®, R:Chat®, R:PDF Form Filler®, R:FTPClient®, R:SFTPClient®, R:PDFWorks®, R:Magellan®,
R:WEB Reports®, R:WEB Gateway®, R:PDFMerge®, R:PDFSearch®, R:Documenter®, RBInstaller®,
RBUpdater®, R:AmazonS3®, R:GAP®, R:Mail Viewer®, R:Capture®, R:Synchronizer®, R:Biometric®,
R:CAD Viewer®, R:DXF®, R:Twain2PDF®, R:Scheduler®, R:Scribbler®, R:SmartSig®, R:OutLink®,
R:HASH®, R:JobTrack®, R:TimeTrack®, R:Manufacturing®, R:QBDataDirect®, R:QBSynchronizer®,
and R:QBDBExtractor®, and Pocket R:BASE® are trademarks or registered trademarks of R:BASE
Technologies, Inc. All Rights Reserved. All other brand, product names, company names and logos are
trademarks or registered trademarks of their respective companies.

Windows, Windows 11-10, Windows Server 2025-2016, Azure Maps, Word, Excel, Access, SQL Server,
and Outlook are registered trademarks of Microsoft Corporation. OpenOffice is a registered trademark of
the Apache Software Foundation. 
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Printed:  July  2025 in Murrysville, PA

First Edition

1.3 License

R:BASE TECHNOLOGIES, INC. LICENSE AGREEMENT 
 

RBInstaller 2.0
Single Seat License 

 
This is a legal agreement between you, the end user ("Licensee"), and R:BASE Technologies, Inc.
("RBTI"). Please read the terms and conditions of this License Agreement before using this software. By
you selecting "I accept the license agreement" and clicking "Next" during product installation means you
expressly accept the terms and conditions of this Agreement. If you do not accept the terms and
conditions of this Agreement, you must stop installing the Product and click "Cancel". Your money will be
refunded based upon proof of purchase, and in compliance with the return period described in the
LIMITED WARRANTY below. A violation of the License, brings damage both financially and to the
reputation of RBTI, and in the occurrence of either, both termination of the license agreement and civil
damages will be vigorously sought. Once you have clicked "I accept the license agreement", you are
entitled to use the Product under the following terms and conditions of this Agreement:

LICENSE
This RBTI License Agreement permits you to use one copy of the RBInstaller computer software with
associated utilities (the “Program”) and accompanying user documentation (the “Documentation”) on
any single computer provided the Program is being used on only one computer at a time. A Program is
“being used” on a computer when it is loaded into a temporary memory or installed on a hard drive in
the computer. However, a copy of the Program installed on a network server for the sole purpose of
distribution to other computers is not “being used”. Each seat having access to the Program must have
an appropriate license. If you anticipate that the number of seats with access to the Program will exceed
the number of seats for which you are licensed, you must take steps to ensure that the appropriate
licenses are obtained for each seat.

COPYRIGHT AND RESTRICTIONS
RBTI retains full ownership rights in the Program and Documentation. You may make a single copy of the
Program; to be used solely for backup or archival purposes, or you may transfer the Program onto a
single hard disk provided you keep the original solely for backup or archival purposes. Such copies shall
be owned by RBTI. You may not copy any printed material or Documentation without prior permission.
You may not decompile, disassemble cross-compile, reverse engineer, or make or distribute any other
form of, or derivative work from, the Program. You may not obscure, alter or remove any RBTI
copyright, trademark or proprietary rights notices.

TRANSFER OF LICENSE
You may not lend, rent or lease the Program or Documentation or any copies to any person. A transfer
of license is only authorized through completion of the Consent to Assignment and Assumption of
Contract agreement from RBTI. Upon license transfer, you are permanently giving such person
possession of all copies of the Program and Documentation, are permanently giving up your right to use
the Program and Documentation, and the recipient agrees to the terms of this License Agreement. 

STEP UPS AND UPGRADE PURCHASES
As the Licensee, you are authorized to use the Program only if you are an authorized user of a qualifying
product as determined by RBTI. The new license agreement takes the place of the agreement of the
qualifying software you stepped up or upgraded from. After you upgrade, you may no longer use the
software from which you upgraded. When you install the upgrade, you must uninstall the copy of the
qualifying product.

TERM OF LICENSE
The licensing provided in this License Agreement is perpetual unless you violate any of its terms or
conditions, at which time the license will automatically terminate. Upon termination you must return all
copies of the Program and Documentation to RBTI or certify in writing to RBTI that all such copies have
been destroyed and uninstalled from each workstation and/or network server. RBTI reserves the right to,
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at its expense and without prior notice, conduct periodic inspections for licensing compliancy. If licensee
is found to be in violation of current agreement, RBTI may commence a civil action seeking fines,
damages, attorney’s fees and injunctive relief and may also, in appropriate circumstances, seek criminal
prosecution.

SOFTWARE SUPPORT
The availability of software support services is subject to the End of Support (EOS) and End of Life (EOL)
product life cycle, and to an active Software Assurance Plan. Where applicable, licensees will be provided
with an option to upgrade to the current supported version of a software product.

LIMITED WARRANTY
RBTI warrants to you, as the initial user, the Program will perform substantially in accordance with the
Documentation, provided it is used in unaltered form with functioning equipment and operating systems
for which it was designed. RBTI will, at its option, with proof of payment within 30 days of the invoice
date and after the Program with Documentation has been deactivated and uninstalled, and software
installer, whether provided by download or other means, permanently deleted from all drives and
folders, issue a full refund. These are your sole remedies for any breach of warranty. No exceptions will
be made.

SERVICES PROVIDED WITH PURCHASE

1. 30-Day Limited Complimentary Technical Support 

LICENSEE RESPONSIBILITIES

· To help us expedite the process and provide high quality assistance, the licensee must
provide proof of purchase when calling. Proof of purchase is defined as the following:
registration number, purchase date, version and build number, and company or individual to
which product is registered.

· To have operating system, workstations, and local network installed and functional. RBTI will
NOT be responsible for resolving issues not pertaining to the Program.

· Our support staff deals with advanced issues, therefore the person contacting RBTI for
assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES
· To provide quality assistance in a timely manner to aid Licensee in the installation of the

product within 30 days of the date of purchase.
· To provide a reasonable solution for any resolvable issue.  Not all issues are resolvable, and

therefore we will acknowledge the existence of known issues or “bugs” which we are
presently aware of, that have no reasonable work-around.

RBTI reserves the right to limit the amount of support time allotted to a maximum of 2 HOURS
during the 30-Day Complimentary Technical Support Period.  We also reserve the right to limit the
quantity of calls from a particular Licensee to 30 MINUTES in a single day.  Issues are dealt with
on a case-by-case basis, and are handled at the discretion of the support agent assigned to the
case. Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related
issues ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

2. Fixes for Known Issues
RBTI will provide continued product fixes for known issues or “bugs” for 1 YEAR from the software
purchase date. After 1 year, users are urged to acquire the necessary Software Assurance Plan to
continue with product support and ongoing activations for reinstallations and license transfers.

3. Enhancement Requests
RBTI will provide continued product enhancements for requested features for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software Assurance
Plan to continue with product support and ongoing activations for reinstallations and license transfers.

NO OTHER WARRANTIES
Except as explicitly stated above, RBTI makes no express or implied warranties (including any warranties
of merchantability or fitness) with respect to the character, function, or capabilities of the program, the
documentation or their appropriateness for any user’s purposes. RBTI cannot customize product(s) to
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meet specific needs in all cases. Examples of customization include, but are not limited to: special
character sets, foreign language adaptations, specific device drivers or other localization issues. Under
no circumstances will RBTI be held responsible for product functionality once alterations have been made
to accommodate individual needs.

DISCLAIMER OF WARRANTY
The Program and the accompanying files are sold "as is" and without warranties as to performance or
merchantability or any other warranties whether expressed or implied. Because of the various hardware
and software environments into which the Program may be put, No warranty of fitness for a particular
purpose is offered. Good data processing procedure dictates that any program be thoroughly tested with
non-critical data before relying on it. The user must assume the entire risk of using the Program. Any
liability of the seller will be limited exclusively to product replacement or refund of purchase price.

HIGH RISK ACTIVITIES
The Program is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, air traffic control, aircraft navigation or communication systems, direct life
support machines, or weapons systems, in which the failure of the Program could lead directly to death,
personal injury, or severe physical or environmental damage ("High Risk Activities"). RBTI specifically
disclaims any expression or implied warranty of fitness for High Risk Activities. 

LIMITATIONS ON LIABILITIES
RBTI will not be responsible for any costs or damages associated with loss of the use of the Program or
any other resources, loss of business or profits, any loss of data, any third-party claims or costs of
substitute programs. In no event will RBTI be liable for any incidental, indirect, special, consequential or
punitive damages suffered by the user or any other person or entity, whether from the use of the
program or documentation, any failure thereof, or otherwise, even if RBTI or its dealers or agents are
aware of the possibility of such damages. In no event will RBTI aggregate liability to you or anyone else
exceed two times the license fee you paid for the program and documentation in this package. Because
some states do not allow the limitation or exclusion of implied warranties and liabilities for consequential
or incidental damages, the above limitations may not apply to you.

GENERAL
This License Agreement constitutes the full and complete agreement between parties. RBTI retains all
rights not specifically granted herein. RBTI shall not be deemed to have waived any of its rights
hereunder or under all copyright laws, trade secrecy laws or otherwise. This Agreement is intended as a
legally binding agreement which will be enforced to the full extent permitted under applicable law, in
whole or in part. If any one provision of this Agreement is declared invalid or unenforceable, all
remaining provisions shall never less remain in effect. The laws of the state of Pennsylvania shall govern
this Agreement. RBTI reserves the right to amend, alter, or revoke this agreement at any time. All
revisions to this license agreement are available for inspection upon request, supersede conditions in all
past agreements, and render prior license agreements void and unenforceable. Both parties named in
this license will only be bound to the terms of the most current revision of this agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication or disclosure by the Government, its agents or employees is subject to all restrictions
imposed by law, regulation or government directive, including but not limited to those restrictions set
forth in DFARS 252.227-7013 and 48CFR 52.227-19, as applicable.

R:BASE Technologies, Inc.
https://www.rbase.com
rbaseinfo@rbase.com

Copyright 1982-2025 R:BASE Technologies, Inc. 
All Rights Reserved
Revised Monday, July 07, 2025

1.4 Complimentary Support

30 DAY LIMITED COMPLIMENTARY TECHNICAL SUPPORT

A. LICENSEE RESPONSIBILITIES.
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1. To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase. Proof of purchase is defined as the following: registration number, purchase
date, version and build number, and company or individual to which product is registered.

2. To have operating system, workstations, and local network installed and functional. R:BASE
Technologies will NOT be responsible for resolving issues not pertaining to the software product.

3. Our support staff deals with advanced issues, therefore the person contacting R:BASE Technologies
for assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

4. To have the database, application, and command files being reviewed, safely backed-up before
attempting assistance. R:BASE Technologies will NOT be held responsible for lost data or corruption
as a result of advice given.

B. R:BASE TECHNOLOGIES, INC. RESPONSIBILITIES.

1. To provide quality assistance in a timely manner to aid in the installation of the product and
elementary conversion of database, application, and command files within 30 days of the date of
purchase.

2. To provide a reasonable solution for any solvable issue. Not all issues may be solved, and
therefore we will acknowledge the existence of known issues, or bugs, which we are presently
aware of, that have no reasonable work-around.

R:BASE Technologies reserves the right to limit the amount of support time allotted to a maximum of 2
HOURS during the 30-Day Complimentary Technical Support period. We also reserve the right to limit the
quantity of calls from a particular licensee to 30 MINUTES in a single day. Issues are dealt with on a
case-by-case basis, and are handled at the discretion of the support agent assigned to the case.
Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related issues ONLY.
Our support hours are Monday through Friday, from 10:00 AM to 6:00 PM (EST).

For application, design, or advanced conversion assistance, R:BASE Technologies offers Technical
Support Plans of various types to meet your needs. Please visit the Support page at
https://www.rbase.com/support for details and pricing.

https://www.rbase.com/support
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2 Installation

2.1 System Requirements

The following system specifications are recommended for the optimal use of R:BASE and R:BASE-related
software. 

Workstation Hardware

· 2-Core 2GHz+ CPU
· 2 GB of available RAM (4 GB recommended)
· 2 GB of available hard disk space
· 1024x768 or higher resolution video adapter and display
· Standard mouse or compatible pointing device
· Standard keyboard

Server Hardware

· 2-Core 2GHz+ CPU
· 6 GB of available RAM (8 GB recommended)

Operating System

· Microsoft Windows 11 (Professional)
· Microsoft Windows 10 (Professional)
· Microsoft Windows Server 2025
· Microsoft Windows Server 2022
· Microsoft Windows Server 2019
· Microsoft Windows Server 2016

Network

· Ethernet infrastructure (Gigabyte recommended)
· Internet connection recommended, but not required, for license activation, software updates, and

support
· Anti-virus programs should exclude the R:BASE program, and any add-on product, executable and

database files

2.2 Software Installation

The installation of RBInstaller is fully automated, and does not require user intervention for the initial
configuration.

Run the installer ".exe", provided by download, while physically sitting at the workstation to begin the
installation process, and read the installer screens for licensing and other information as the program
installs.

Installation Directory

C:\RBTI\RBInstaller

Files Installed

RBInstaller.exe
RBInstallerConApp.exe
rbuninstall.exe
RBInstaller.chm 
RBInstaller.pdf
License.rtf 
ReadMe.txt
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3 Getting Started with your Installer Project

Before you begin building your first installer project, it is advised to organize your computer "product"
and associated files into an individual product production directory. This would include the product
executable, help documentation, database files, plugins, license, "readme" text file, icons, and image files
that would be displayed across the top and side of the installer dialog window, etc.

In addition to the product files, you will also be required to include the "rbuninstall.exe" file into a
[PROGRAMDATADIR] destination sub-folder. This will place the executable and a .log file that will take
care of uninstalling your product if the end user chooses to do so.
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4 Load/Save Project to XML

On the RBInstaller toolbar there are two options for working XML for the installer project, "Load from
XML" and "Save to XML". The options are in place to provide time-saving project changes for major
"upgrades" for your program versions.

For example, if your program migrated from 4.2 to 5.0, you would be able to save the project to an XML
file, perform a search and replace for version numbers, file names, etc., then load the XML file back into
RBInstaller.
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5 Project Definition

5.1 Files

Use the "Files" option to add your software product files to the installer project. The top half of this screen
contains a Directory Tree navigation control on the left for you to navigate to a specific directory where
your project files are located. On the right side, a File List control is used to display the list of files for the
selected directory in the Directory Tree control. The bottom half of the screen offers directory locations
for your application project to be installed on the destination computer. The RBInstaller supports three
directories for files to be placed. 

· WINDOWSDIR - the Windows root directory (e.g. C:\Windows,  C:\WINNT)
· SYSTEMDIR - the System root directory (e.g. C:\Windows\System32, C:\WINNT\System32, C:

\Windows\SysWOW64)
· SYSTEMDIR64 - the System root directory for 64-bit files (e.g. C:\Windows\System32, C:

\WINNT\System32)
· USERDIR - the target folder for user configuration files (*.cfg). For the "User Information" dialog >

"Anyone who uses this computer", the path is C:\Users\Public. For the "User Information" dialog >
"Only for me (User Name)", the path is C:\Users\<UserName>

· PROGRAMDATADIR - the target folder for program environment files (*.ini, *log). For the "User
Information" dialog > "Anyone who uses this computer", the path is C:\ProgramData. For the "User
Information" dialog > "Only for me (User Name)", the path is C:
\Users\<UserName>\AppData\Roaming.

· TARGETDIR - the target directory for your software program (e.g. C:\Program Files\Adobe)

Additional sub folders can be added within the USERDIR, PROGRAMDATADIR, and TARGETDIR paths.
Only one TARGETDIR can be specified.

In addition to the product files, you will also be required to include the "rbuninstall.exe" file into a
[PROGRAMDATADIR] destination sub-folder. This will place the executable and a .log file that will take
care of uninstalling your product if the end user chooses to do so.

Add Files
To add a displayed file from the File List, click and drag the file on top of the selected destination folder
using your computer mouse. The destination folder must first be selected in order for the file(s) to be
associated to the destination folder.  Files can also be added by using the "Add File(s)" button. After files
have been added, they will appear in the "Destination Computer" structure.

New Folder
A new folder can be added to the Target Directory by selecting [TARGETDIR] and pressing the "New
Folder" button. You can then change the new folder name by selecting it and editing the "Folder Name:"
field.

Delete
To delete a file or folder, select the item and press the "Delete" button.

Installation Group
Within this dialog, specific files can be added to to defined Installation Groups. To assign a file to a
installation group, right click on the file, select "Custom Group". The list of defined groups will be
available. An entire sub-folder for the TARGETDIR can be specified to be added to a group, but the
TARGETDIR itself cannot be specified.

The "Use in Compact Installation" option is used to specify limited files that will be installed to minimize
the size of the program installation. After files are assigned, an additional "Components" dialog will be
displayed in the installation process. 



Project Definition 19

Copyright © 1982-2025 R:BASE Technologies, Inc.

5.2 Product Details

The "Product Details" screen provides options to define product information which will be provided to the
end user. 

Name:
The complete name of your product application. 

Version:
The product application version. A version string has the format "a.b.c.d" where a, b, c and d are
numbers. The following are examples of valid version strings: "3", "7.6", "2.11", "5.10.5". 

Manufacturer:
The full name of your company.

Default Directory:
The default installation directory for product application. The "Allow Browse" check box will allow users to
alter the default installation directory where your product will be installed. 

Product Code:
The Product Code is the unique identifier that is assigned to your product. This code is stored in the
Windows registry to prevent end users from accidentally reinstalling the program when it is already
installed. This value can also be referenced by you in the R:Updater software program. 

The registry location where the Product Code will be stored is:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

Userdata Key:
The Userdata Key is the unique identifier that stores the default installation directory for the product
application. This key can be referenced by you in the R:Updater software program. 

The registry location where the Userdata Key will be stored is:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Installer\UserData\S-1-5-
18\Components

Readme text:
The Readme text panel allows you to load an ASCII text file which can contain product information or
release notes for your application. The text will be displayed within the Readme Dialog window during the
installation process. The text file must already exist before you load it into your project, and must have
the .txt file extension. 
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If you want to change the Readme text information already listed, you must use the "Clear" button to
clear the contents of the panel, and then select the "Load" button to load in a new Readme text file.

Supported OS
The list of supported operating systems for the installer package.

5.3 General Information

The "General Information" is for specifying detailed information about the executable that is created at
the end of the RBInstaller compilation.

The bulleted details below are stored in the "Summary" tab within the compiled executable:

· Title - the application title
· Subject - a subject for the application 
· Author - the application author
· Keywords - any appropriate application keywords
· Comments - the application comments

Use Password - Allows password security for the install package

Output File Name - Specifies the name for the compiled executable
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Files Date/Time - Specifies the date/time stamp for the files installed

5.4 Add/Remove Programs

This information is displayed in the list of "Programs" installed within the operating system Control Panel,
which can be set to not appear at all.

Display Icon
This is the icon displayed for the product. Choose an .ico or .exe file that has been added to your
[TARGETDIR] program folder by using the "Browse" button. 

Icon Number 
The icon number is the numeric value for the selected ico/exe file. If you select an executable, there is a
possibility that there is more than one icon stored within the executable, so different icon numbers would
be presented to you. Otherwise, the icon number will always be zero (0).

Support Information Page
This information is displayed when a user selects the "Support Information" option when selecting your
program in the "Add/Remove Programs" applet.

· Online Info URL - The URL of the application's home page 
· Contact Person - The contact person for technical support
· Phone Number - The phone number where the user can get technical support
· Help URL - The URL where the user can get technical support
· Comments - A more detailed description of the application 

5.5 Resources

The "Resources" menu provides options to load a Rich Text license agreement, and images that will be
displayed during the installation process.

Rich Text License
The "Rich Text License" panel will load an RTF file which contains a product license agreement. The
license will be displayed within the License Dialog window during the installation process. The rich text file
must already exist before it is loaded it into your project, and must have the .rtf file extension. 
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To change the license information already listed, use the "Clear" button to clear the contents of the
panel, and then select the "Load" button to load in a new license file.

Dialog Images
The "Dialog Images" panel loads images that are displayed across the top and to left of the installer
screen dialogs. The same or multiple images can be displayed within the Dialog windows during the
installation process. The image files must already exist before they are loaded it into the project, and
must have the .bmp file extension. 

Load - changes an existing bitmap
Save - saves the new image that was just loaded
Add New - adds a new image to the list
Delete - deletes the selected image

Notes:

· Two sample images are provided with RBInstaller. To use different images, make sure that the same
transparency and dimensions are used. 

· When using custom images, integrate the naming convention values "Left" or "Side" for images to be
assigned to the left side of the dialog windows, and "Top" for images to be assigned to the top of the
dialog window. This will allow you to assign the images to the appropriate dialog location much easier
in the Dialogs screen for installer project settings. 
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6 Details

6.1 Registry

The "Registry" screen adds registry keys and values to the install package. Keys and values can be
added to any of the following registry hives: 

· HKEY_CLASSES_ROOT 
· HKEY_CURRENT_USER
· HKEY_LOCAL_MACHINE
· [64]\HKEY_LOCAL_MACHINE
· HKEY_USERS

When a registry key is added, and selected, the below items* will be displayed.

Registry Key Name*
Specifies the key name

Delete On Uninstall*
When checked (default), the uninstall process will remove the key. The font color for the key is black.
When unchecked, the key will be retained when the program is uninstalled, where the key font color will
be green. 

Delete All On Uninstall*
Toggles the status that the uninstall process will remove all of the keys

Keep All On Uninstall*
Toggles the status that the uninstall process will keep all of the keys

Toggle Delete/Keep Status*
Toggles the delete/keep status for all displayed keys

Prompt to delete Registry entries
Displays a prompt for the uninstall process to remove registry keys. When checked, selecting "Remove
registry entries" will delete all keys regardless of the individual key's delete/keep setting. Selecting to
"Keep registry entries" will keep all keys regardless of the individual key's delete/keep setting.

Import 
Use the "Import" button to import registry entries from a Windows Registration File (.reg).

Export
Use the "Export" button to export any selected registry items from the "Registry" screen to a Windows
Registration File (.reg). The functionality is helpful when using different installer projects where the
registry keys are common.

DELETE ALL KEYS
Deletes all keys and values.

Add Key
Adds a default key. With the key selected, edit the key name using the "Registry Key Name" field. 

Delete Key/Value
Removes a selected key or value.

New Value
While the focus is on the desired Key displayed, a new value is added. With the focus on the registry
value, the screen will refresh to define the Value Name, its type (DWord, String, or Hex), and content.
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6.2 Shortcuts

The "Shortcuts" screen creates and edits existing desktop shortcuts for files in the installer project. 

Adding/Editing a Shortcut
With a shortcut, a dialog is displayed to select the appropriate file from the [TARGETDIR], and define the
program shortcut settings for the file.

· Name - the name of the shortcut, which will appear on the end user's desktop
· Target File - the program executable 
· Dest. Directory - the destination for the shortcut. The follows values can be used:

· [STARTPROGRAMS] - places a shortcut to a file within the "Start Programs" group
· [DESKTOP] - places a shortcut to a file on the desktop

· Arguments - the program arguments that appear after the target file, like the "-A" argument 
· Description - the description of the target program, which is displayed as a hint from the

desktop 
· Start In Directory - the directory where the program will launch from
· Show Window - sets the Window display; Normal, Minimized, or Maximized
· Icon File - the icon which will appear on the desktop. Choose an .ico or .exe file that has been

added to your [TARGETDIR] program folder by using the "Browse" button. 
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· Icon Number - the icon number is the numeric value for the selected ico/exe file. When selecting
an executable, there is a possibility that there is more than one icon stored within the executable,
so different icon numbers would be presented. Otherwise, the icon number will always be zero (0).

Deleting a Shortcut
Use the "Delete" button to remove a shortcut.

Duplicating a Shortcut
Use the "Duplicate" button to duplicate a selected shortcut.

The up/down arrow buttons will move the shortcut in the list.

6.3 Services

The "Services" screen will install and control Windows native services. Only a file included in the
installation can be installed as a service. 

Adding/Editing a Service
A dialog is displayed to select the appropriate file from the install file, and define your program service
settings for the file. A Service file is usually loaded into the  [SYSTEMDIR] location.

· Service Name - the service name to be installed by your package
· Display Name - the display name to be installed by your package
· Path - the path where the service file will be installed
· Install Action - specifies the install operation performed (Start, Stop, None)
· Uninstall Action - specifies the uninstall operation performed (Start, Stop, None)

Deleting a Service
Use the "Delete" button to remove a service.

6.4 Register ActiveX

The "Register ActiveX" screen will install and register a Dynamic Link Library file(.dll) or an Object
Linking and Embedding custom control file (.ocx).  Only a file included in the installation can be
registered. 

Add
A dialog is displayed to select the appropriate file from the install files. The file is usually loaded into the 
[SYSTEMDIR] location.

Delete
Use the "Delete" button to remove the file.

6.5 Environment Variables

The "Environment Variables" screen will add environment variables to the install package. These
variables are added on the target machine during install.

Adding/Editing an Environment Variable
With an Environment Variable, a dialog is displayed to define the variable settings.

· Variable Name - the variable name to be installed by the package
· Variable Value - the variable value to be installed by the package

Deleting an Environment Variable
Use the "Delete" button to remove an Environment Variable.
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6.6 Dialogs

The "Dialogs" screen will specify which installer dialogs will be displayed during installation process, and
what images can be assigned to each.

To enable/disable any of the available dialogs in the installation process, select the appropriate Dialog
name from the "Install Dialogs" list box, and toggle the "Use Dialog for installation" check box. 

When the desired Dialog name is selected, assign the specific image using the "Left Bitmap" and "Top
Bitmap" drop down boxes. The values displayed in the drop down boxes are based upon the Dialog
Images that  were added to the installer project. 

6.7 Custom Actions

The "Custom Actions" screen will specify a custom action for the installer project after the installation is
complete.

Adding a Custom Action
Select the "Add New" button to add a new custom action. The following menu selections will be enabled:

Action Name - the custom action name
File Name - the custom action file name
Parameters - the parameters controlling the custom action
Wait for Action End - enables the installation process to wait for the custom action
Ask About Action - prompts the user 
Run on Uninstallation - enables the action when the program is uninstalled 
Message Text - displays a message 

6.8 Uninstall Process

The "Uninstall Process" screen specifies an exclusion list of files that would not be uninstalled when a user
uninstalls the program. 

6.9 Installation Groups

Specifies a group of files to be listed as an optional package that is loaded on the computer during the
installation process. For example, an installer may offer various language packs that a user may not
want to include during the installation process.

· Group Name - specifies the group name
· Required - specifies if the group is required, for example, core files that are needed in order for

the program to run
· Description - specifies the group description
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After a Group Name is defined, the Files screen must be revisited in order to assign specific files to a
defined Group. To assign a file to a installation group, right click on the file, select "Custom Group". A list
of groups will be available. An entire sub-folder for the TARGETDIR can be specified to be added to a
group, but the TARGETDIR itself cannot be specified.

After the Installation Groups are defined, an additional "Components" dialog will be displayed in the
installation process. 

6.10 Force Uninstall Items

The "Force Uninstall Items" screen specifies items that are forced to be uninstalled when a user uninstalls
the program, even if the uninstall process cannot complete.
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7 Compiling Projects

When compiling installer executable, each compilation can be saved as a project. This allows you to save
the custom settings for future compilations, or to make slight changes, and create separate compilation
projects. Multiple projects can be used for different products and different versions of your programs. 

After your project files are assigned to your project and all other settings have been configured, compile
your installer project by selecting either of the available options:

· Choose "Project" > "Compile " from the Menu Bar

· Select the "Compile" button from the Tool Bar

To locate your update executable, there will be a "Compile" folder containing your Output File Name and
a text file containing the same MD5 checksum data. A "Temp" folder will also be created, which is used to
stored temporary data during the compile process.

7.1 Saving Projects

After making changes to your existing projects or creating new projects, always save your work.
RBInstaller project files are saved with the .rui file extension.

To save any changes you make to an existing project, you can perform either of the available options:

· Choose "File" > "Save" from the Menu Bar
· Select the "Save" button from the Tool Bar

To save any changes you make to an existing project as another project name, you can perform either
of the available options:

· Choose "File" > "Save As..." from the Menu Bar
· Select the "Save As..." button from the Tool Bar

7.2 Recompiling

The first step to recompiling your installer executable is to open your saved RBInstaller project file (.rui).
You can load your RBInstaller project settings by performing either of the available options:

· Choose "File" > "Open" from the Menu Bar
· Select the "Open" button from the Tool Bar

Next, confirm the loaded settings. If needed, you may need to load a different project file. To compile the
project file, you can perform either of the available options:

· Choose "Project" > "Compile " from the Menu Bar
· Select the "Compile" button from the Tool Bar

After testing, the executable is ready for distribution.

7.3 Command Line Options

Command line options are available to run the "RBInstallerConApp" executable to automatically compile
installer projects from a command line prompt.

Syntax:

RBInstallerConApp.exe "-parameter value"

Parameters:
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Parameter Description

SCRIPT_NAME specifies the RBInstaller .rui project file

README_FILE_NAME specifies the README.TXT file

LICENSE_FILE_NAME specifies the LICENSE.RTF file

OUTPUT_FOLDER specifies the output directory

OUTPUT_FILE_NAME specifies the output executable file name

VERSION specifies the product version number (##.##.##.#####)

MD5_OUTPUT specifies if the MD5 output is generated (ON/OFF)

DATETIME_STAMP specifies the date and time stamp for installed files

REPLACE_IMAGE specifies a different top or left image 

Sample:

C:\RBTI\RBInstaller\RBInstallerConApp.exe "-SCRIPT_NAME C:
\RBTI\RBInstaller\Scripts\MyApp8_1.rui" "-README_FILE_NAME C:
\RBTI\RBInstaller\ProjectsAndFiles\MyApp8_1\README.TXT" "-
LICENSE_FILE_NAME C:
\RBTI\RBInstaller\ProjectsAndFiles\MyApp8_1\LICENSE.RTF" "-OUTPUT_FOLDER
P:\My_App8_1\" "-OUTPUT_FILE_NAME MyApp8_1_Installer_2024_F2AD963P.exe"
"-MD5_OUTPUT ON" "-DATETIME_STAMP 01/06/2024 08:10:00" "-REPLACE_IMAGE|
Left.bmp|C:\RBTI\RBInstaller\Version8_Left.bmp" "-REPLACE_IMAGE|Top.bmp|
C:\RBTI\RBInstaller\Version8_Top_Icon.bmp"
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8 Technical Support

Please read over the help documentation at least once before seeking support. We have worked very
hard to make the help documentation clear and useful, but concise. It is suggested that you reread these
instructions once you have become accustomed to using the software, as new uses will become
apparent.

If you have further questions, and cannot find the answers in the documentation, you can obtain
information from the below sources:

· Email our Technical Support Staff at: support@rbase.com
· Access the R:BASE Technologies Support home page online at https://www.rbase.com/support

You may be required to purchase a technical support plan. Several support plans are available to suit the
needs of all users. Available Technical Support Plans

Please be prepared to provide the following:

· The product registration number, which is located on the invoice/order slip for the purchased product
· The type of operating system and hardware in use
· Details regarding your operating environment; such as available memory, disk space, your version

of R:BASE, local area network, special drivers, related database structures, application files, and
other files that are used or accessed by your application

All provide information will be used to better assist you.

R:BASE Technologies has a number of different services available for R:BASE products. As a registered
user, you will receive information about new features for R:BASE and other R:BASE Technologies
products. Please remember to register your software. https://www.rbase.com/register/

mailto:support@rbase.com
https://www.rbase.com/support
https://www.rbase.com/support/plans.php
https://www.rbase.com/register/
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9 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like a software product to do
differently. 

If you come across an idea that you think might make a nice enhancement, your input is always
welcome.

Please submit your suggestion and/or enhancement request to the R:BASE Developers' Corner Crew
(R:DCC) and describe what you think might make an ideal enhancement. In R:BASE, the R:DCC Client is
fully integrated to communicate with the R:BASE development team. From the main menu bar, choose
"Help" > "R:DCC Client". If you do not have a login profile, select "New User" to create one.

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the request. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted enhancement request. 

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

Reporting Bugs:

If you experience something you think might be a bug, please report it to the R:BASE Developers'
Corner Crew. In R:BASE, the R:DCC Client is fully integrated to communicate with the R:BASE
development team. From the main menu bar, choose "Help" > "R:DCC Client". If you do not have a login
profile, select "New User" to create one.

You will need to describe: 

· What you did, what happened, and what you expected to happen
· The product version and build 
· Any error message displayed
· The operating system in use 
· Anything else you think might be relevant 

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the bug report. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted bug.

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

mailto:rdcc@rbase.com
mailto:rdcc@rbase.com
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